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Starting Merkato 
Before you start, be sure you have a username and password for Merkato. You will need 
the URL (web address) of the Merkato portal. 

Logging In 

Point your browser to the Merkato portal. The opening page looks like the one below: 

 
Enter your username and password and click Login. 

(If you need a username and password, contact your Merkato Administrator.) 
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When you successfully log in, the Merkato Agent screen appears: 

 
From the Merkato Agent screen you can get to the various other screens that make up the 
Merkato interface. 

Planning For Your Bandwidth Needs 

Before you buy bandwidth you should plan your bandwidth needs. 

A good way to determine your bandwidth needs is to calculate your data transfer rate 
requirements. Merkato specifies the rate in kbps, Mbps, or Gbps. (See “Units Conversion 
Chart” on page 36.) 
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Reserved or Spot-Market Bandwidth? 
There are two ways to purchase bandwidth in a Merkato system. 

• You can request and reserve a fixed amount of bandwidth, at a fixed price, for a 
fixed term. 

• You can create a bidding strategy and contend for bandwidth with other buyers, 
establishing a fair market price based on supply and demand. 

The first method is called the Reservation market and uses a Reservation agent. The 
second method is called the Spot market and uses a spot agent. 

To get bandwidth from the spot market, you configure your Merkato agent to bid on your 
behalf in a continuous bandwidth auction. To get bandwidth in the reservation market, 
use your Merkato agent to ask for a fixed-price quote, based on the quantity and duration 
you specify. Bandwidth may be obtained on both markets simultaneously and combined 
into a single allocation. 

(For a complete description of each method, see Merkato Buyer’s User Manual, “Spot 
Market and Reservation Market Agents.”) 
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Buying Reserved Bandwidth 
The reservation agent allows you to obtain an allocation of bandwidth that begins 
immediately and ends at a date and time you specify. 

Before you begin this process, make sure your PC’s system date and time is correct.  (On 
Microsoft Windows desktops, double click on the time display at the end of the task bar 
to access the time and date controls.) Otherwise, you may see discrepancies between the 
quoted duration of reservations and the actual duration of the reservation when it is 
confirmed. 

To buy reserved bandwidth, perform the following procedures. 

Log in to the Merkato portal. (See “Logging In” on page 1.) 

From the user interface pull-down menu in the browser window, select “Desktop” and 
click select. 

 
If the Java plug-in works correctly, you see a series of download messages. (If you do not 
have the correct Java plug-in, see “Java on Your Browser” on page 35.) The Merkato 
Desktop window appears.  
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Downloading the Agent 
To download an agent, follow these steps: 

1. From the File pull-down menu, select “Download Agent.” 

 
 

The Download Agent window appears. 

 
2. Enter the username and password for the desired agent. 

By default, this is the same as the username and password you used to access the 
Desktop interface from the initial login; the fields are populated with this 
information. You may specify another valid username and password to download 
another agent. 
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3. If there are Garage choices on a pull-down list that indicates both spot and 
reservation marketplaces, select the reservation garage and click Download. 

 
 

If you have a single generic choice in the Garage field, your Merkato 
administrator will have given you two distinct usernames and passwords—one for 
each market. In this case, make sure that the username and password correspond 
to the reservation market and click download. 

The Agent window appears. This is the Agent interface through which you make 
your reservation. 
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Making the Reservation 
1. Connect to the marketplace by clicking on the Connect icon ( ). 

2. If the News window is not visible, select “News” from Status pull-down menu. 
The News window appears. 

 

3. Click the Start icon ( ). 
4. Read the available bandwidth capacity from either the News or the Resource 

window. If this capacity is greater than or equal to what you want, proceed. (If 
not, you can either attempt to obtain what is available or consider buying 
bandwidth on the spot market.) 

5. From the Strategy pull-down menu, select “Reservation Strategy.”  (Expand the 
display area, if necessary, to see the Reservation Strategy window at the bottom. 

 

6. Click the pack icon ( ) on the menu-bar or select “Pack” under the View pull-
down. The agent window resizes itself to accommodate the windows you are 
currently displaying. 
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7. In the Reservation Strategy window, select the end date and time for your 
reservation using the pull-down fields in the End Time area of the window. (The 
requested start time is always the current time.) 

 
As you make changes to the end time and date, the Merkato calculates the 
duration of the reservation and shows it in the Reservation area of the window. 
Note: If the quantity (Mbps) or time units (month) in the Reservation area do not 
suit your needs, you can change the units. Select Units from the Selection pull-
down menu. The Units box lets you use kbps, Mbps, or Gbps, as well as minutes, 
hours, days, or months. 

8. Enter the amount of bandwidth you want in the Reservation portion of the box. 

9. Make sure the Current Strategy radio button at the top of the box is checked, 
making the current strategy active.  

10. If you are satisfied that the quantity and duration specified, click Get Quote. A 
confirmation box appears. 
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11. If the price and cancellation fee are acceptable, click Accept. Otherwise, click 

Refuse and revise your reservation request. 

Once you click Accept your reservation is activated. 

You can create multiple overlapping reservations. Merkato combines the 
aggregate bandwidth into a single large allocation. 

12. To review or cancel your reservation, select “Reservation Table” from the Status 
pull-down menu. The Reservation table appears. 

 
13. To cancel a reservation, select it from the Reservation table and click Cancel 

Reservation. 

14. When you have accepted your reservation, upload your agent by clicking the up-

arrow icon ( ). 

15. When the confirmation window appears, click OK. The agent closes but the 
Merkato desktop window remains. 

Exiting Merkato 
To exit the Merkato desktop, click the close-box tab at the upper right hand corner of the 
window (r), or select “Exit Merkato” from the File pull-down menu. 



   

 

10  InvisibleHand Networks, Inc.  
Buyer’s Guide to Using Merkato 

You can leave the portal page in the browser open to monitor your agent status, or click 
Logout in the list on the left side of the window. 
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Buying Bandwidth on the Spot Market 
On the spot market, bandwidth is distributed by a system that ranks bidders by the price 
they offer, but charges them based on the price offered by the lowest bidder to receive an 
allocation of bandwidth (the “fair market price” for bandwidth at that time).  If you bid 
too low in an auction you will be out-bid by other buyers.  

The spot market is intended for immediate bandwidth to be used immediately; it provides 
true bandwidth-on-demand. The changes you make to your agent’s bidding profile take 
effect immediately and a resulting allocation will be granted in less than five minutesat 
the close of the auction in progress. You may start and stop bidding at any time. 

Note: Bidding From the Garage or From the Desktop 

Although the auction allocation process runs continuously, there is no need for you 
to be directly involved at all times. Your agent can bid automatically for you after 
you configure it with a profile of the value you place on bandwidth. Your agent 
communicates with the seller’s agent on a Merkato platform called the Garage. The 
Garage is Merkato’s name for auction services it runs from a server.  

Once you configure your agent, you can either bid from your PC using a Java-based 
application, or communicate remotely with your agent as it bids from the Garage. 

Bidding from your PC and operating a remote agent each has advantages. On your 
PC, the Merkato desktop display gives you real-time information about the auction 
and its participants. If you are not interacting with the agent, you can configure it and 
upload it to the garage. It will continue to run, and you avoid the chance of ceasing to 
bid if your PC crashes or you have network connectivity problems. 
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Choosing an Interface 

You can chose from among three interfaces to get information and handle transactions. 
The User Interface menu lets you make the choice. 

 
• The Desktop interface allows you to purchase bandwidth through a series of user-

selectable windows. Your agent is brought to your PC and bids on your behalf 
from there. 

• The Express interface lets you get status information from—and send 
configuration information to—an agent in the garage. The Express interface is at 
the top of the Portal page when you log in. The Express interface is considered 
advanced because the fields are less interactive, less annotated, and less graphical 
than the Java-based Merkato Desktop interface. Note that the Express interface 
does not support creation or cancellation of reservations. 

• The Wizard interface walks you through the steps for setting up your Merkato 
agent to obtain bandwidth through the spot market. The settings are automatically 
transferred to your agent. Changes made through the Wizard are applied to both 
the Desktop and Express agents. You can later change the settings from the agent 
interfaces, or return to the Wizard and make changes there. 

When you first log in, the Express interface appears in the browser window, to the left of 
the interface selection field. 

We recommended that you select the Wizard interface first to make basic buying choices. 
When you become more advanced in your use of Merkato you can make further changes 
to the Desktop interface. The Desktop interface also gives you the most detailed status 
information. As you become more proficient with Merkato, you may want to use the 
Express interface to make quick configuration changes and status checks without 
downloading your agent to your PC. 
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Using the Wizard 

The Wizard interface walks you through the steps to set up Merkato to obtain bandwidth. 
You can use the Wizard to set up bidding from your PC or from the Garage. (See “Note: 
Bidding From the Garage or From the Desktop” on page 11.) 

If you launch the Wizard from the Merkato portal it will configure an agent in the garage.  

If you start the Desktop interface and launch the Wizard, it configures the desktop 
interface. (This configuration is applied to your Garage agent profile when you save or 
upload.) 

To access the Wizard from the Merkato portal, select it from the portal user interface 
menu, as shown below. 

 
The Wizard takes you step-by-step through configuration of your Merkato spot-market 
agent. It provides detailed help on each page. You can activate the Help display by 
clicking the check box at the bottom of the screen, between the Next and Apply buttons). 

 
When you reach the final screen of the Wizard, you have: 

• Specified the bandwidth resource which you would like to obtain 

• Selected units for display of currency, bandwidth quantity, and time 
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• Set a minimum amount of bandwidth that you would like to obtain 

• Set a maximum amount of bandwidth that you would like to obtain 

• Set a budget that you do not want to exceed when bidding for bandwidth between 
your minimum and maximum thresholds 

The final Wizard screen lets you confirm your choices and apply them to your agent. It 
gives you the option to begin bidding after it applies configuration changes are applied to 
your agent. 

 
To begin obtaining bandwidth in the spot market immediately, do the following: 

1. Select “Apply the settings and start bidding” from the pull-down list. 

2. Click Apply at the bottom of the screen. 

• If you launched the Wizard from the Merkato Desktop, the Desktop agent is 
active and bidding. 

• If you launched the Wizard from the Merkato portal: 
� In the confirmation window, click Yes to indicate that you want to quit the 

Wizard and apply the settings. 

� Select “Express” from the pull-down interface selection list. 
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The results of your configuration appear in the Express interface, shown 
below. 

 
The Status in the Express interface indicates that the Agent is active, 
showing that the Agent is currently bidding. 
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Using the Desktop Agent 

You can use a Desktop agent to bid from your PC. You can also use the desktop to 
conveniently make setting changes, and then upload your configured Desktop agent and 
bid from a garage. (See “Note: Bidding From the Garage or From the Desktop” on page 
11.) 

For a complete description of fields in the Desktop agent, see Merkato User Reference 
for Buyers, “Desktop Interface.” 

Downloading the Desktop Agent 
To bid using the Desktop agent, do the following: 

1. From the Merkato portal, select Desktop from the user interface menu and click 
select. 

 
The Desktop window appears, as shown below. 

 
2. From the File pull-down menu, select Download Agent. The Agent Download 

login box appears. 

 
3. By default, the user name and password you used to enter the Merkato portal 

populates the Agent Download login box. Change this if necessary to make sure 
you download the correct agent. 
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4. Select a garage from the pull-down menu. Make sure the garage you select is the 
one that contains the desired Spot market agent. You may have a separate garage 
for your Reservations agent, as well as garages for multiple Spot market agents, if 
you are allowed to purchase bandwidth from multiple markets simultaneously. 
(See “Note: Bidding From the Garage or From the Desktop” on page 11.) 

5. Click Download on the Agent Download login box. When the agent finishes 
downloading it appears on the Merkato desktop, as shown below: 
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Arranging Sub-Windows within the Agent Window 
The agent window consists of smaller sub-windows, each of which can be displayed or 
closed as you wish. By default, windows are stacked vertically in the agent window, as 
shown below. 

 
Each time a window is selected for viewing, it appears beneath the previously activated 
window. To close a window click the close-box tab at the upper right hand corner of the 
window (r). The window closes and the other windows fill in the spot it occupied. 
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To freely drag boxes within the agent window, de-select the Stack ( ) icon or go to the 
View pull-down menu and de-select Stack. 

 
To resize the agent window to exactly match the windows displayed, click the Pack icon 

( second from right) or select Pack from the View pull-down menu. 
Note: To arrange Agent windows on the Merkato desktop, see Merkato User Reference 
for Buyers, “Arranging Agent Windows.” 
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Select Bidding Units 
In the Units fields, you can make changes to money, time, or bandwidth units. Changing 
units doesn’t change your bid—it converts the displayed values to the ones you choose. 

1. From the Selection pull-down menu, select Units. The Units box appears (though 
you may have to expand the agent box to see it). 

 
2. Use the pull-down menus in the Currency, Quantity, and Time fields to pick the 

units you want to see in the other agent boxes. 
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Select a Valuation 
Your valuation settings indicate the maximum amount you are willing to pay for a range 
of desired bandwidth. In the course of an auction, your agent uses this valuation 
information, together with the market price, to determine how much to bid and how much 
bandwidth to ask for, in response to changing market conditions. 

For a description of the methods of valuation, see Merkato User Reference for Buyers, 
“Valuation Overview.” 

1. From the Valuation pull-down menu, select a valuation method. 

 
2. Create your valuation by filling in the fields. The fields are different depending on 

which valuation method you select. 

3. Select the Current Valuation radio button. 

4. Click Apply. (The Apply button changes from yellow to blue when a parameter is 
changed, and back to yellow when the change takes effect.) 

Changes to valuations only affect bidding if that particular valuation is activeindicated 
by the radio button at the top of the window and the green arrow in the pull-down menu 
list. If a valuation is not active, the changes are stored until you active that valuation. 
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If market conditions are such that you get no allocation (or choose not to bid), this does 
not necessarily mean that your traffic has no bandwidth available to it. The data streams 
of agents that do not bid (or do not win any allocation) are generally funneled through a 
single, shared amount of permanently allocated bandwidth. Ask your Merkato 
administrator how much bandwidth is allocated to this “best effort queue” so that you can 
make the best decision of when to stop bidding on the low end (see budget-with-limits 
valuation). 

Using Traffic-Based Bidding 

 
If you use the Traffic-based tab in the valuation window, your agent changes its 
maximum quantity by checking the usage at intervals. The agent measures the amount of 
traffic at intervals you set (in the Meas. Window field). The agent bids for that amount of 
bandwidth, plus a quantity margin you set (in the Qty Margin field). The quantity margin 
can prevent your agent’s maximum bid quantity from reaching zero at times of no traffic. 
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The following diagram illustrates the relationship between the settings: 

 
Each valuation window has a Traffic-based tab, and each one serves the same function.  

To use Traffic-Based valuation, do the following. 

1. In the Meas. Window field, enter the time interval at which you want your agent 
to adjust its bidding based on traffic volume. (You may want to change the units 
shown in the field to a shorter period. The smallest interval you can select is six 
minutes.) 

2. In the Qty Margin field, enter the amount above the measured traffic you want 
your agent to use as maximum requested quantity in calculating its bid. 

3. Check the Active check box. 

4. Click Apply to active the changes you made to your agent. 
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Select a Strategy 
You can bid using an automatic strategy or a manual strategy.  

� An automatic strategy changes your bid continually according to market 
conditions and your valuation settings.  

� A manual strategy lets you make one-time bids at a set quantity and price. 

(For a complete description of Merkato strategies, see Merkato User Reference for 
Buyers, “Strategy Overview.”) 

Note: If the quantity (Mbps, for example) or time units (month, for example) displayed 
do not suit your needs, you can change the units. Select Units from the Selection pull-
down menu. The Units box lets you use kbps, Mbps, or Gbps, as well as minutes, hours, 
days, and months. (See “Select Bidding Units” on page 20.) 

Automatic Strategy 
1. From the Strategy pull-down menu, select Auto Strategy. 

 
2. In the Auto Strategy window, select the Current Strategy radio button. 

If you select Automatic strategy, your agent starts bidding for you immediately. 

The Auto Strategy window lets you see your bids as they are submitted. With Auto 
Strategy active, your agent bids, if it has a sufficient budget, every time the market price 
exceeds its last submitted bid. (Since the market price is determined by the price offered 
by the lowest successful bidder, a bid under this price does not receive an allocation.) 

The field on the left shows the quantity requested in your agent’s last bid. The field on 
the right shows the unit price your agent offered in its last bid. 
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Manual Strategy 
1. From the Strategy pull-down menu, select Manual Strategy. The displayed 

quantity and unit price are those of your last bid. 

 
2. Enter the amount of bandwidth you want to bid for in the left field. 

3. Enter the maximum you can spend in the right field. 

When you connect to the garage, clicking Bid sends your bid to the auction. Note that 
this is a one-time event.  The submitted bid is not carried over to the next auction round.  
If you wish to place a single take-it-or-leave-it bid each auction round, use the Linear 
valuation with the Automatic strategy. 

Connecting and Starting Your Agent 
The three icons at the upper left of the icon bar are, (from left to right) “Connect,” 
“Start,” and “Stop.” 

 
When you first download an agent it is not connected to the auction. Your agent cannot 
bid when it disconnected, although you can set its configuration. When the connect 
symbol on the icon bar (on the far left) is un-depressed and un-colored the agent is 
disconnected. 

When you connect to the auction, until you click the Start icon, you may observe the 
auction but you are not participating in it. 

When you want to start bidding click the Start icon (  second from left on the icon 
bar). Bidding starts immediately with the current settings. 

To stop bidding, click the Stop icon (  third from left on icon bar). Your agent stops 
bidding and is disconnected. To begin viewing the auction again you must connect again. 
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Viewing Your Allocations 
The Allocation window provides information about the quantity of bandwidth bought and 
the price paid for that bandwidth at the close of each successive auction. It also monitors 
the time left in the current auction. 

To view the Allocation window 

 
During an auction, the Time Left field counts down the seconds left in the auction. 

When the auction ends and an allocation is made to your agent, its quantity and cost 
appear in the left-hand side of the Allocation window. It remains displayed until you get 
another allocation or you disconnect the agent. 
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Viewing Auction History and Current Data 
In addition to the Allocation window, Merkato provides a variety of other tools to let you 
view past and current auction data. These include the following: 

Auction Graph—Indicates the state of the Merkato auction in progress, for all agents 
actively bidding. Colors and shapes on the graph indicate each bidder’s last bid, your 
previous allocation, your proposed allocation, your bandwidth valuation, and other 
information. 

Auction Table—Shows a quantitative, real-time view of the auction in progress. 

News Window—Shows the real-time status of your agent and the capacity and price 
currently offered in the market (if the agent is connected). 

You can use this information to optimize your bidding strategy in relation to other 
bidders in the auction. 

See the Merkato User Reference for Buyers for details about these tools. 
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Letting Your Agent Bid Without You (Uploading) 
You can set your agent to bid continually for you. You don’t need to monitor it and you 
don’t need to run it on your PC. You can upload it to the garage, where it remains active 
and continues to bid on your behalf. This ensures that you continually get the bandwidth 
you need at the best price, based on the valuation you set when you configure the agent. 
Simply upload your agent to the garage. You can continue to monitor it via the Express 
interface on the Portal, but if you close the desktop or shut off your PC, the agent 
continues to function as you have set it. 

To upload and exit, do the following: 

1. Click the up-arrow icon ( ). The confirmation message indicates the garage 
where your agent will be placed. 

2. When the confirmation window appears, click OK. If the agent is connected when 
you upload it, the following message box appears: 

 
1. Click OK. 

The agent closes but the Merkato desktop window remains. 
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Saving Your Configuration 
You may want to save the settings you made on the desktop agent, to your garage agent 
profile, without exiting from the desktop agent. We recommend this to ensure that if your 
PC freezes or reboots, your configuration changes are not lost. 

If you want to save the way your agent is configured, but not transfer your agent to the 
garage, do the following: 

1. From the File menu, select Save Configuration: 

 
A confirmation box appears, asking which garage you want to save your 
configuration it. (If multiple garages are available, they will appear in a pull-down 
list.) 

 
2. Make sure the garage listed is the one you want to save to (generally the garage 

you downloaded the agent from), and click OK. 

3. Click OK to confirm saving your configuration. 

Exiting the Merkato Desktop 
To exit Merkato, click the close-box tab at the upper right hand corner of the window 
(r), or select “Exit Merkato” from the File pull-down menu. 

You can leave the portal page in the browser open to monitor your agent status (via the 
Express agent), or click Logout in the list on the left side of the window. 
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Using the Express Agent 

The Express interface is an HTML version of the Desktop interface, with some 
significant differences: 

• It leaves your agent in the garage and controls it remotely. (See “Note: Bidding 
From the Garage or From the Desktop” on page 11.) 

• Your screen is not updated in real time. You must click Refresh to update 
information in status displays. 

• You may not create or cancel reservations through this interface. Nor can you 
submit manual bids or make changes to traffic-based valuation settings. (Existing 
settings made in these areas through the Desktop interface are not affected by 
using the Express interface to change other settings.) 

The Express interface is meant to support advanced users who know what the fields mean 
and wish to have a quick way to check agent status or make configuration changes. 

(See Merkato User Reference for Buyers, “Express Agent.”) 

The Express agent is the first screen you see when you log in on the Merkato Portal. 

When you first log in, the window looks like the one below. 
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Valuation and Strategy 
You must configure the Express agent to bid using either an automatic strategy or a 
manual strategy. An automatic strategy changes your bid continually according to your 
valuation settings and market conditions. It bases the bid on the market price, your 
valuation parameters, and the amount it is informed it would receive if no more bids were 
submitted (and this auction round closed). 

A manual strategy (submitting bids manually) is not supported through the Express 
interface, but this strategy setting will be indicated if previously configured (and 
uploaded) via the Desktop interface. 

(See Merkato User Reference for Buyers, “Strategy Overview.”) 

You must also configure the Express agent with a valuation method. 

Your valuation settings indicate the maximum you are willing to pay for a range of 
bandwidth. In the course of an auction, your agent uses this valuation information to 
determine whether to bid, how much bandwidth to ask for, and how much to offer, in 
response to changing market conditions. 

In the express interface, you can view and change settings for inactive or the active 
valuation. You do this by making a selection under the “Valuation View” pull-down 
menu. The valuation parameters automatically change to reflect the selected valuation.  
To make the new valuation active, click Apply. The “Current Valuation” display changes 
to the valuation currently being viewed, and the agent begins bidding using the new 
valuation profile and settings. 

(See Merkato User Reference for Buyers, “Valuation Overview.”) 

Controlling the Express Agent 
The Refresh and Apply buttons at the bottom of the window control communication 
with your agent: 

• Refresh updates the read-only status fields in the windows without sending 
configuration changes to the Agent. All values saved the last time changes were 
applied are restored. 

• Apply updates the read-only status fields in the windows and sends configuration 
changes to the Agent. 

For a complete description of fields in the Express Agent, see Merkato User Reference 
for Buyers, “Express Agent.” 

Bidding From the Express Agent 
To bid for bandwidth from the Express agent, follow these steps: 

1. Make sure the spot market is selected in the Resource field. 

2. Select Auto bidding strategy in the Strategy field. 
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3. Select a valuation in the Valuation View field. (For a description of the methods 
of valuation, see Merkato User Reference for Buyers, “Valuation Overview.”)  

4. In the Units fields, you can make changes to money, time, or bandwidth units. 
Changing units doesn’t change your bid—it changes the display to show the units 
you choose. 

5. In the Min Qty field, enter the Minimum bandwidth you want to buy. (A line 
through this field means that no entry is necessary.) 

6. In the Max Qty field, enter the maximum bandwidth you want to buy. (A line 
through this field means that no entry is necessary.) If the maximum quantity is 
the all the seller is selling, check the Max Qty = All check box. 

7. In the Budget/Max Value field, enter the appropriate currency per unit/time value 
for the valuation you selected. For budget-based valuations, this is the maximum 
amount of money you are willing to spend on the acceptable range of bandwidth 
you want to buy. For other valuations, this value is related to the maximum you 
are willing to spend, but does not directly correspond to it. The Merkato User 
Reference for Buyers, “Valuation Overview” explains how to configure these 
details for each valuation.) 

8. When you are satisfied with all entries, click Apply. The “Current Valuation” 
display changes to the Valuation View you configured. 

9. If you want to begin bidding now, click the active radio button in the Status area. 

10. Click Apply to begin bidding. A Bid field appears in the display, indicating the 
amount of your current bid. Click Refresh to update this display at any time. 

11. In five to ten minutes, click Refresh again. The Allocation field appears. It 
displays the bandwidth you have won, and its cost, in the completed auction. 
Click Refresh to update this display. 
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Below is the Express interface, as it appears after you complete these procedures. 
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Viewing Historical Information 

The Allocation Table shows bandwidth allocated to the current user and the amount 
charged for this bandwidth. Allocations are shown in order, most recent at the top (sorted 
by End Time). Each row corresponds to a single reservation (for Reservation market 
resources), and for an hourly roll-up of auction results (for Spot market resources). The 
Allocation Table indicates that Merkato auctions have been providing the desired results. 
You may obtain information for longer timeframes in the Billing display via custom 
queries.  

The Market Price History display shows the unit price paid by all successful bidders for 
the bandwidth they received. Fluctuations of this price indicate changes in the dynamics 
of the market—bidders entering or leaving the market or altering their valuation profiles. 

The Market Price History display includes two market price graphs: 

• Average market price on an hourly basis. 

• Average market price on a daily basis. 
For a full description of Express agent fields, see Merkato User Reference for Buyers, 
“Express Agent.” 
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Java on Your Browser 
If your browser is not configured for Java version 1.3.1 you must download it before you 
can run a Desktop agent. You can allow Merkato to do this automatically, or you can 
download it directly from the source whose link is provided in the login page. 

There are later versions of Java, but we do not recommend using them. 

Automatic Download 

If your browser doesn’t have Java version 1.3.1, the first time you attempt to download a 
Desktop agent you are guided through the installation of the Java plug-in. 

Reply “Yes” to all security permission requests. 

Active Download 

If you encounter problems, you can download Java free from Sun Microsystems. The 
URL is: 

http://java.sun.com/products/plugin/
Note: As of this writing, to get the plug-in, you must download the entire Java Run Time 
Environment, which is greater than 5 MB. Netscape version 6.1 for Windows appears to 
support the Merkato Java applications, but it is not fully tested for Merkato version 2.1.  
Likewise, the Java 1.3.1 plug-in for Macintosh OS X appears to work as well, but is not 
fully tested for Merkato version 2.1. 
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Appendix 
This section contains information you may find useful as you configure your agent. 

Units Conversion Chart 

If you find it more convenient to think of bandwidth in terms of transfer time for files of 
various sizes, which are expressed on bytes rather than bits, the following chart may be 
helpful.   

GigaBytes/month 
(GB/mo) 

MegaBytes/month 
(MB/mo) 

Megabits/sec 
(Mbps) 

Kilobits/sec 
(Kbps) 

Telco Standard

150 150,000 0.5 463   

166 166,000 0.5 512 512K 

250 250,000 0.8 772   

500.3 500,300 1.5 1,544 T-1 

1,000 1,000,000 3.1 3,086   

5,000 5,000,000 15.4 15,432   

10,000 10,000,000 30.9 30,864   

14,495 14,494,500 44.7 44,736 T-3 

15,000 15,000,000 46.3 46,296   

16,796 16,796,000 51.8 51,840 OC-1 

20,000 20,000,000 61.7 61,728   

25,000 25,000,000 77.2 77,160   

30,000 30,000,000 92.6 92,593   

40,000 40,000,000 123.5 123,457   

50,389 50,388,500 155.5 155,520 OC-3 

75,000 75,000,000 231.5 231,481   

100,000 100,000,000 308.6 308,642   
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Valuation Summary Chart 

 Linear Square 
Root 

Budget Budget 
With 
Limits 

Logarithmi
c 

Parabolic 

Bandwidt
h 
Quantity 

Flexible Fluctuate
s with 
market 

Fluctuate
s with 
market 

Uses 
minimum 
and 
maximu
m range 

Fluctuates 
with 
market 

Fluctuates 
with 
market 

Price Fixed – 
price per 
unit 

Fluctuate
s with 
market 

Fluctuate
s with 
market 

Fluctuate
s with 
market 

Fluctuates 
with 
market 

Fluctuates 
with 
market 

Budget Proportiona
l to 
quantity 
received 

Decreases 
with 
decreasin
g quantity

Constant 
regardles
s of 
quantity 
received 

Constant 
if 
quantity 
received 
is within 
range 

Peaks at 
middle of 
quantity 
range 

Peaks at 
middle of 
quantity 
range 

Agent 
Actions 

Agent bids 
at constant 
unit price 
regardless 
of quantity. 

Agent 
increases 
bandwidt
h request 
as market 
price 
drops, 
and 
decrease 
request as 
price 
increases. 

Agent 
purchases 
all 
bandwidt
h 
possible 
for $XX. 

Agent 
will 
purchase 
bandwidt
h only up 
to X 
amount, 
even if 
price 
drops.   

Agent bids 
aggressivel
y at the 
mid-point 
of a 
quantity 
range. Use 
if you want 
a certain 
bandwidth 
amount, 
but will 
take more 
at lower 
cost.  

Agent bids 
aggressivel
y at the 
mid-point 
of a 
quantity 
range. Use 
if you want 
a certain 
bandwidth 
amount, 
but will 
take more 
at lower 
cost.  Bids 
less 
aggressivel
y than the 
Log 
valuation at 
lower 
amounts of 
bandwidth. 

 


